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CCHHAAPPTTEERR  11..  IINNTTRROODDUUCCTTIIOONN  

IINNTTRROODDUUCCTTIIOONN  
Welcome to the RealFlight NexSTAR Edition R/C Simulator.  The NexSTAR 

Edition is the ideal way to learn to fly, practice maneuvers or just have an incredible 

amount of fun.  It's so realistic, you’ll hardly believe it’s a simulation. 

The NexSTAR Edition offers an amazing array of tools to help you understand how 

to use the program, and how to improve your R/C piloting skills. From extensive 

ToolTips that explain every option as you use it, to our Virtual Flight Instructor™ 

feature, to our extensive manual and technical support, RealFlight NexSTAR Edition 

is the perfect way to practice flying your new airplane. 

After you've mastered the NexSTAR Edition, be sure to check out the complete 

version of the RealFlight software. The complete version of the software offers 

many, many exciting options, features and functions that are not found in the 

NexSTAR Edition.  No other R/C simulator goes further to enrich your R/C 

experience.  For more information, please visit: www.realflight.com 
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CCHHAAPPTTEERR  22..  BBEEFFOORREE  YYOOUU  BBEEGGIINN  

SSYYSSTTEEMM  RREEQQUUIIRREEMMEENNTTSS    
The system requirements below are what we consider to be the minimum PC 

configuration in which the RealFlight NexSTAR Edition software should be 

installed. Meeting the minimum requirements will allow you to still enjoy the 

simulation; however, in order to take complete advantage of the many features and 

functions offered, you should have a computer at, or near, the specifications as listed 

under the optimum system requirements. 

MINIMUM SYSTEM REQUIREMENTS 

 Windows® XP*, 2000*, ME or 98SE  

* Local administrator access required for Windows XP or 2000 

 Intel® Pentium® 300 or equivalent processor 

 64 MB RAM 

 DirectX® 8.1 (or above) compatible video card with at least 8MB of 

RAM (Note that Voodoo I and Voodoo II cards are not supported 

because they do not allow you to run in a window or view a menu 

while full screen) 

 DirectX 8.1 (or above) compatible sound card 

 500 MB hard drive space 

 4x CD-ROM drive 

 Super VGA monitor 

 USB port 

SUGGESTIONS FOR OPTIMUM PERFORMANCE 

In addition to the requirements above: 

 Intel Pentium III 600 (or equivalent) and above processor 

 Microsoft® Direct 3D compatible high performance 3D accelerated 

video card with 16 MB (or more) video RAM 

 16x CD-ROM drive 

 128 MB RAM 
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VVIIDDEEOO  AANNDD  SSOOUUNNDD  CCAARRDDSS  
In order to achieve optimum performance and the ultimate satisfaction, there are two 

important components of your computer that deserve special attention: the video and 

sound cards. 

While the software will work well on a wide variety of hardware configurations, it 

offers many features that are designed to take particular advantage of the latest video 

technology. If you have an older computer, or a newer computer with a lower-end 

video card, you may want to consider purchasing a new video card to take advantage 

of these features. This moderately priced upgrade can vastly enhance your enjoyment 

of the RealFlight NexSTAR Edition. Aside from increasing your satisfaction with 

RealFlight, a new video card will also work with many other games or simulators, 

improving their performance as well. 

While not as important as a video card, upgrading your sound card may also improve 

your satisfaction.  This is especially true if your computer uses an on-board sound 

card (that is, a sound card affixed to the motherboard.) 

 

GGEETTTTIINNGG  TTHHEE  MMOOSSTT  OOUUTT  OOFF  RREEAALLFFLLIIGGHHTT  NNEEXXSSTTAARR  

EEDDIITTIIOONN  
 

We think you’ll agree that for both beginners and experienced pilots, RealFlight 

NexSTAR Edition offers the finest set of instructions and practice tools of any R/C 

simulator.  Great Planes and Knife Edge Software are committed to the continual 

improvement of our products. When using the software, there are two things you 

should keep in mind. 

First, similar to other pursuits, what you gain from the simulator depends directly 

upon what you put in. Mastering radio control requires a great deal of patience and 

practice. If you crash in the simulation, take it very seriously. Crashing an actual R/C 

aircraft can cost you a lot of time and money. Try to examine what you did 

incorrectly, using the experience to avoid making the same mistake again.   

Second, while the simulator is quite realistic and will assist you in learning many of 

the skills necessary to become a proficient pilot, there is no substitution for actual 

stick time.  No simulator, no matter how realistic, can completely replace a qualified, 

experienced, human flight instructor. A simulation can be a wonderful practice tool. 

However, if you’re new to R/C, you should never attempt to fly a real aircraft 

without the supervision of a qualified instructor, no matter how well accomplished 

you are on the simulator.
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CCHHAAPPTTEERR  33..  GGEETTTTIINNGG  SSTTAARRTTEEDD  

OOVVEERRVVIIEEWW  
This chapter covers the installation procedure for the RealFlight NexSTAR Edition 

software, describes the basics in running the program, and will introduce you to 

some of the most often used features. 

The first section, Installing RealFlight NexSTAR Edition offers a step-by-step 

approach to the installation procedure for both the program software and the USB 

Transmitter Interface. 

The second section, Exploring RealFlight NexSTAR Edition, offers a brief tour of the 

program.  You'll learn how to perform some basic functions, such as using the 

Virtual Flight Instructor feature. 

IINNSSTTAALLLLIINNGG  TTHHEE  RREEAALLFFLLIIGGHHTT  NNEEXXSSTTAARR  EEDDIITTIIOONN    
 

PROGRAM INSTALLATION 

This section will explain how to install the RealFlight NexSTAR Edition software 

and the USB Transmitter Interface. When you finish this section, you should be able 

to fly the NexSTAR, using your NexSTAR transmitter to control the airplane. 

UPDATE DRIVERS 

Before you begin installation, we strongly suggest that you update the drivers for 

both the sound and video cards.  A driver is a software program that your computer 

uses to control hardware devices. Each card has its own respective driver. Most 

problems with installing and using RealFlight, as well as many other programs that 

use DirectX, arise from outdated video and/or sound card drivers. 

If you’re not sure how to update your drivers, you can find instructions in article 

Q01-1038, How to Update Drivers, at http://www.gpsoftware.com/kb/q01-1038.htm. 

This article will take you through the process step-by-step, and includes links to 

driver download sites for most manufacturers. 

http://www.gpsoftware.com/kb/q01-1038.htm
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START INSTALLING THE PROGRAM 

Once you’ve installed the new drivers, you’re ready to install the software. First, turn 

your computer “on” and close any applications you are running. Next, insert the 

RealFlight NexSTAR Edition CD-ROM into the CD-ROM drive.  If Auto-Play is 

active, the RealFlight NexSTAR Edition Control Panel will appear.  Click the Install 

CD button located at the top of the Control Panel to begin the installation process.  

If Auto-Play is not active, you will need to locate and run the program 

“SETUP.EXE” from the root directory of the CD-ROM.  To do this, click the Start 

button on the Windows Taskbar, then select Run from the Start menu. In the Run 

window, type “d:\setup” (assuming “d:\” is the designation for the CD-ROM drive) 

and press [Enter] or click “OK”. This should start the setup program. 

RUNNING THE INSTALLATION PROGRAM 

Follow the onscreen instructions and fill in the necessary information when queried 

by the setup program.  When the setup program asks for the program serial number, 

use the RealFlight NexSTAR Edition serial number as it appears on the back side of 

the CD-ROM case.  This number must be entered exactly as it appears in order to 

proceed to the next phase of the installation process. 

INSTALL DIRECTX 

After the program has finished copying the necessary files, it will ask you if you 

want to install DirectX.  If you do not meet the minimum DirectX version 

requirement as queried by the RealFlight program, click “Yes” to install this updated 

version of DirectX.   

It will not harm your computer to install DirectX more than once.  Therefore, if you 

are unsure as to the status of this program we suggest that you install it at this time.  

When DirectX has been installed, click “Finish” to complete the Setup. 

CONNECT THE USB TRANSMITTER INTERFACE 

Finally, plug the RealFlight NexSTAR Edition Transmitter Interface into a USB port 

on your computer (see diagram). On most computers, the USB ports are clearly 

labeled. 

 

Please note, the Transmitter Interface is hot pluggable or hot swappable. In other 

words, you can normally plug/unplug the Transmitter Interface without turning your 

computer off or rebooting. 
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While your Transmitter Interface is plugged in, and your computer is turned “on”, a 

small green light on the Transmitter Interface should illuminate. This light, labeled 

“USB Active”, indicates that the Transmitter Interface is connected and working. 

Grasp the remaining Transmitter Interface cord (the one with the square connector) 

and firmly plug this into the trainer jack (a.k.a. buddy box) port located in the back 

of the NexSTAR transmitter.  Turn the transmitter’s power “on.” 

RUN REALFLIGHT NEXSTAR EDITION 

To complete the installation and start the program, click on the RealFlight NexSTAR 

Edition icon located on the desktop.  RealFlight NexSTAR Edition will guide you 

through the final installation. 

Now you are ready to run the RealFlight NexSTAR Edition simulator. 

EEXXPPLLOORRIINNGG  TTHHEE  RREEAALLFFLLIIGGHHTT  NNEEXXSSTTAARR  EEDDIITTIIOONN  

PPRROOGGRRAAMM  
Now that you’ve installed the RealFlight NexSTAR Edition, it’s time to begin 

exploring the program. The following sections will take you on a quick tour of the 

features and functions.  Along the way, we'll show you where to go for help, or how 

to obtain additional information. 

START THE PROGRAM 

After installation, you should see a RealFlight NexSTAR Edition icon on your 

computer's desktop.  First, close all open programs and windows (RealFlight 

performs best when it is the only program running, i.e., not sharing resources with 

any other programs or applications.)  Next, start RealFlight NexSTAR Edition by 

double-clicking the icon. 

THE REALFLIGHT NEXSTAR EDITION’S MAIN DISPLAY 

When you first run RealFlight, you should see a window like the one below 

(assuming your video card supports DirectX Window mode, most cards do).  
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You can move, resize, minimize, maximize and restore the RealFlight main window 

just as you would any other application.  

You interact with RealFlight using the menus in the main window’s menu bar: 

 Airport 

 Aircraft 

 Options 

 View 

 Help 

If the simulator is running but you do not see any window borders or menus, you 

may be running in full screen mode. “Full screen mode” means that the RealFlight 

NexSTAR Edition’s main display will take up your entire monitor screen. If this is 

the case, you can access the menus by hitting your keyboard’s “ALT” key or, 

alternatively, the “ESC” key. For additional information about window mode and 

full screen mode, see “Run in Window” on page 26. 

Later in this manual, you’ll find a separate chapter for each menu. These later 

chapters will describe, in detail, every single menu item and option. For now, 

though, we want to show you two aspects of the RealFlight user interface: 

 How to navigate the menus and find out what the different commands 

do; and  

 How to perform some of the most common tasks—optimizing the 

settings for your PC, accessing the VFI, etc. 

Menus 

Menus allow you to access RealFlight commands. To open a menu, click on its title 

(e.g., Aircraft): 
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Dialog ToolTips 

If you see a RealFlight dialog, and want to know what a control (button, checkbox, 

etc.) in that dialog does, simply place the mouse cursor over the item until a ToolTip 

window appears. For example: 

 

 

SOME COMMON TASKS 

 To reset your aircraft to its original takeoff position, select “Reset 

Position” under the “Aircraft” menu. Alternatively, you can also press 

your keyboard’s space bar.  
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 To zoom in on an aircraft, select “Zoom in” in the “View” menu. 

Alternatively, press your keyboard’s F2 key. Repeat to increase the 

zoom level further.  Use F3 to zoom out, or use F1 to reset to the 

default zoom level. 

VIRTUAL FLIGHT INSTRUCTOR™ 

RealFlight NexSTAR Edition’s Virtual Flight Instructor (VFI) provides you with 

private flying lessons from an award-winning, industry professional.  

To start a lesson, select Virtual Flight Instructor located in the Options menu. 

When a dialog appears, select the lesson you want to view. 

 

Click “OK”, and RealFlight does the rest. You will see the instructor’s aircraft fly 

the maneuver. You’ll hear the instructor’s voice, explaining how it’s done. You can 

watch the instructor’s actual stick movements using an onscreen, digitized R/C radio.  

The main window will show the instructor’s plane. The onscreen radio will show the 

instructor’s stick movements. 

WWHHEERREE  TTOO  GGOO  FFRROOMM  HHEERREE  
 

Now that you’ve received a brief overview of the simulator, we encourage you to 

explore RealFlight further using some of the methods below. 

 If you’d like to learn more about a particular menu or item, look it up in 

this manual’s table of contents. 

 If you’d like RealFlight to do something, but can’t find an appropriate 

command, check this manual’s index.  

 Use the Help facilities in RealFlight’s “Help” menu. 
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 Talk to other RealFlight users. When you visit 

http://www.knifeedge.com, check out our discussion board. 

  

 

http://www.knifeedge.com/
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CCHHAAPPTTEERR  44..  UUSSIINNGG  RREEAALLFFLLIIGGHHTT    

IINNTTRROODDUUCCTTIIOONN  
Chapter 3 took you on a brief tour of some of RealFlight’s most popular features 

found in the NexSTAR Edition. This chapter will provide you with a broad overview 

of all RealFlight features, and advise you how and where to find detailed information 

about the features that most interest you. 

 

PPRROOGGRRAAMM  FFEEAATTUURREESS  
 

SUMMARY OF FEATURES 

 Next generation graphics technology— RealFlight takes complete 

advantage of today’s state-of-the-art 3D accelerated video cards, 

providing the smoothest and most realistic flight experience possible. 

RealFlight uses incredibly detailed, 24-bit textures on aircraft, trees, 

buildings and landscape to add to the authenticity.  

 Uses VirtualRevolution™ sound technology— Doppler-correct stereo 

sounds heighten the realistic effect with actual recordings of an R/C 

engine.  And as the aircraft crosses the field, the engine sound follows, 

just like its R/C counterpart.  Aside from the various ambient noises 

such as other pilots conversing and birds chirping, RealFlight includes 

numerous CD-quality soundtracks in a variety of musical styles and 

original compositions. 

 Uses RealPhysics™ technology— True to the physics of flight, 

RealFlight’s exclusive RealPhysics technology performs hundreds of 

thousands of floating point operations each second. RealPhysics 

delivering sizzling real time flight performance and accuracy.   

 VFI (Virtual Flight Instructor)— VFI gives you personal flight 

lessons from Mike Cross, a full-time aircraft designer and award 

winning R/C pilot.  Using VFI, you can select a maneuver (i.e. loop, 

roll, etc.) from an extensive list.  VFI then demonstrates the maneuver 

onscreen, performed by an expert. While you watch, the voice of the 
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pilot/instructor will explain how to perform the maneuver. You can 

even watch your instructor’s control stick movements in real time to 

determine proper stick input!  

 Flight Playback Gadget— Much like a VCR, this feature also allows 

you to: pause, speed up, slow down, and loop the Virtual Flight 

Instructor’s performance.  The pilot has the option to activate the 

digitized transmitter display so that he/she can view the radio input 

while flying. 

 Collision Detection— The collision detection feature senses when the 

aircraft “bumps” into an object, and causes a crash- just as it would at 

the field.  

 Control Panel— The RealFlight NexSTAR Edition’s Control Panel 

allows for easy one-click program updating, online registration, and 

technical support. 

 Animated control surfaces— The control surfaces and propeller move 

for added realism and authenticity.  

 Extensive Help materials— RealFlight features extensive online 

ToolTips and diagrams, a detailed manual and technical support to 

enhance your enjoyment of the program. 

 

WINDOWS XP, 2000, ME AND 98SE COMPATIBLE 

RealFlight is a native 32-bit program, designed for Windows XP/2000/ME/98SE. It 

uses Microsoft’s DirectX 8.1 to provide cutting-edge graphics realism. 

 

GRAPHICS 

 Supports Gouraud shading, bilinear textures, and dithering. 

 Next generation, high quality 3D objects.   

 Realistic shading on all objects, including the NexSTAR. 

 Transparency.  RealFlight uses transparencies to model the airplane 

propeller for added authenticity. 

 High-resolution graphics, including visible panel lines and moving 

control surfaces, for added realism and authenticity. 

 Optimization-- Graphics Optimization sliders allow the user to 

customize the resolution of the textures, the graphics, and the terrain 

independently to achieve the most realistic look and “feel” for the 

simulation.  The controls also allow the user to tailor the program to 

optimize the performance to his/her PC. 

 Airplane features moveable control surfaces: ailerons, elevators, 

rudders, etc., as well as movable prop for added authenticity. 

SOUND 

 CD-quality soundtrack features a variety of musical styles and original 

compositions; includes ambient sounds typically heard at flying sites. 
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 Doppler-correct stereo effects.  As the aircraft crosses the field, the 

engine sounds follow; just like its R/C counterpart. 

PHYSICS 

 The exclusive RealPhysics technology calculates hundreds of thousands 

of floating point operations each second, delivering sizzling real time 

flight performance and unmatched accuracy. 

 RealFlight’s physics have undergone countless of hours of testing and 

revisions to ensure that the models not only have a lifelike appearance 

but also perform just like their r/c counterparts as well. 

 RealFlight features detailed collision detection.  

 Simple “point-and-click” menus and extensive ToolTips to guide you. 

 

TTRRAANNSSMMIITTTTEERR  IINNTTEERRFFAACCEE  FFEEAATTUURREESS  
This awesome interface brings you: 

 Full USB compatibility. The Transmitter Interface plugs directly into 

your computer’s USB port with little, if any, additional setup required. 

 High-speed data transfer ensures rapid, digitally precise response to 

your control input. 

 Hot pluggable—connect/disconnect your Transmitter Interface adapter 

without shutting down or rebooting the PC. 

 Total control with your actual R/C transmitter.  You’ll get the ‘feel’ for 

controlling the NexSTAR with the same unit you’ll be using at the 

field.  

 

GGRRAAPPHHIICCSS  AANNDD  SSOOUUNNDD  QQUUAALLIITTYY  
The makers of RealFlight continually work to bring you the most realistic graphics 

and sound possible, since we feel that these are important contributions to your 

simulation experience. To do so, we take full advantage of modern video and sound 

hardware. However, we still provide you with extensive, detailed control over 

graphics and sound quality, so that you can usefully run RealFlight NexSTAR 

Edition on computers with widely varying speed, power and performance. 

FRAME RATE 

Frame rate is usually described as how fast the computer can compute and display a 

new “snapshot”.  In other words, it is the rate at which frames (the individual 

pictures that are shown in sequence to create the illusion of motion) are displayed in 

a film or video.  Frame rate is measured in frames per second (fps).  Like a movie 

picture, when stills are quickly flashed by, RealFlight creates a sequence of frames 

that provide the illusion of motion.  Television is flickering the pictures at 30 times 
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per second (30FPS).  A typical movie theater displays about 24/48FPS.  RealFlight 

can produce output ranging from 2FPS to over 150FPS. 

Frame rate is a function of many things and cannot be “set” by the end user.  It is a 

combination of: 

 Computer Speed 

 Video card speed 

 Sound card speed 

 How many optional airport items are selected 

 3D technology selected  

 

In order for the simulator to work best, you should run at a high enough frame rate so 

that you do not notice the picture moving from one frame to the next.  Rather, it 

should appear as a smooth, fluid motion.  If you observe any “stop-and-go” motions 

from the simulation, there are several things that may improve the frame rate. For 

more information, please see “Improving RealFlight Performance” on page 57. 

GRAPHICS QUALITY 

RealFlight is capable of many different levels of graphics quality, some of which are 

entirely dependent upon the video hardware and monitor used.  Control graphics 

variables to configure the simulation to attain the highest possible performance using 

either the “Graphics Optimizations” or “Direct3D” items in the Options menu.  

SOUND QUALITY 

In order to use your sound card with RealFlight, the sound card must support 

Microsoft’s DirectSound.  Many sound cards accelerate the mixing of multiple 

sounds.  RealFlight will take advantage of any acceleration that the card supports.  

This acceleration will free up your CPU, thereby increasing your frame rate. 

 

TTEECCHHNNIICCAALL  SSUUPPPPOORRTT  
Besides providing the best R/C simulator, we sincerely feel that we provide the most 

extensive product support for any R/C simulator. Since cards, drivers, operating 

systems, etc. are always changing, we work hard to keep our support up to date on 

the latest issues and problems RealFlight NexSTAR Edition users might encounter. 

We provide a wide variety of sources for information, help and advice about 

installing, using, and resolving problems with RealFlight (as well as our other 

software products). These sources range from a detailed, publicly accessible product 

knowledge base, to live technical support, to discussion boards. Should you 

encounter any problems with RealFlight access any of these sources, many with a 

click of the mouse or telephone call.  

To learn more about RealFlight’s many support options, please see “Appendix C. If 

You Experience Difficulties With RealFlight …” on page 53. 
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CCHHAAPPTTEERR  55..  TTHHEE  NNEEXXSSTTAARR  UUSSBB  

TTRRAANNSSMMIITTTTEERR  IINNTTEERRFFAACCEE    

AADDDDIINNGG  TTOO  TTHHEE  RREEAALLIISSMM  
By definition, the R/C transmitter is a key component in all types of R/C flying. This 

unique method of control is part of what separates R/C from every other type of 

aviation. Consequently, a realistic transmitter is important to an authentic simulation 

of the R/C experience. 

With this in mind, we at Great Planes are proud to offer our NexSTAR USB 

Transmitter Interface.  

 

The NexSTAR USB Transmitter Interface  

Features of the NexSTAR USB Transmitter Interface: 

 USB compatibility and convenience. The ultimate convenience of 

“plug and play”, “hot pluggable” installation and removal, as well as 

the high-speed digital performance made possible by Universal Serial 

Bus (USB) technology. 

 Use your Actual R/C transmitter.  The Transmitter Interface allows 

you to use your NexSTAR transmitter to control the action.  This is a 

great way to familiarize yourself with the controller before heading to 

the flying field. 

 Easy setup and use. Pre-calibrated so you don’t even have to calibrate 

your NexSTAR transmitter, unlike other computer joysticks. Simply 

plug it in and go! 
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SSTTAARRTT  FFLLYYIINNGG!!  
When you start RealFlight for the first time, the NexSTAR controller is 

automatically calibrated and ready for use.  Simply add throttle and start flying right 

away.  
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CCHHAAPPTTEERR  66..  TTHHEE  AAIIRRPPOORRTT  MMEENNUU  

AAIIRRPPOORRTT  MMEENNUU  OOVVEERRVVIIEEWW  
The Airport menu allows you to access all airport-related features and options. 

When you open up the pull-down menu, you will see: 

 

The items in this menu are:   

 Item Visibility 

 Show Trees 

 Show Fog    

 Weather Conditions… 

The following sections describe the function or purpose of each of these items. 

IITTEEMM  VVIISSIIBBIILLIITTYY  
Use this item to determine whether to show or hide scenery objects in the airport. 

Moving the mouse cursor over this menu item creates a submenu with a list of items 

you can show (make visible) or hide (remove from visibility). To show items, select 

them (check them in the submenu). Conversely, to hide items uncheck them. 
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SSHHOOWW  TTRREEEESS  
This item lets you determine whether or not the trees/foliage will be visible.  This is 

the universal controller of all the trees/foliage.  If this item is checked, then the 

trees/foliage will be visible.  Removing the checkmark will eliminate the trees.   

SSHHOOWW  FFOOGG  
Select this item to toggle “on/off” the Fog options for RealFlight.  This option may 

also be toggled on/off with the keyboard “F”.  Please note, not all video cards 

support the fog option.  

WWEEAATTHHEERR  CCOONNDDIITTIIOONNSS  
Select this item to adjust the weather conditions such as wind speed, gust strength, 

wind direction and thermal activity. 

 

AVERAGE WIND DIRECTION 

This indicates the prevailing direction of the wind.  “0” degrees is North, “90” 

degrees is East, “180” degrees is South and “270” degrees is West.  The prevailing 

direction may be adjusted anywhere between “0” degrees and “360” degrees. 

VARIABLE DIRECTION 

This indicates, in degrees, how the wind direction will vary.  If this field reads “0” 

degrees, the wind direction will remain steady.  However, if the field indicates “360” 

degrees, then the wind may vary through all directions. 

WIND SPEED 

This field indicates the prevailing wind speed.  This is the constant wind speed. 



RealFlight G2 NexSTAR Edition Simulator Chapter 6. The Airport Menu    19 

GUSTS TO 

This indicates the wind gust speed.  The wind speed will intermittently increase to 

this speed.  The Gust slider setting controls the frequency of the wind gusts. 

GUST SLIDER 

This slider is used to adjust the strength of the wind gusts.  If the slider is set to 

smooth, the simulation will provide an unrealistically smooth flight.  Gusty, on the 

other hand, will provide a simulation that will challenge even the most skilled of 

pilots. 

THERMAL ACTIVITY 

This slider indicates the current thermal activity.  If the slider is adjusted to the 

“higher” side of the settings, there are stronger thermal currents.  The thermals 

appear in random locations and will have random strengths.  Over time, they will 

move from one place to another.  You can tell when your plane has entered a thermal 

by watching the plane carefully.  When the plane starts to rise quickly, then you have 

found a thermal.  Quickly turn around and try to stay in that thermal to gain altitude. 
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CCHHAAPPTTEERR  77..  TTHHEE  AAIIRRCCRRAAFFTT  MMEENNUU  

AAIIRRCCRRAAFFTT  MMEENNUU  OOVVEERRVVIIEEWW  
This menu accesses all aircraft related features and options.  When you open the 

Aircraft menu, your display will be similar to the following: 

 

The items in this menu are: 

 Use Pilot Assist… 

 Reset Position 

 Kill Engine 

 

UUSSEE  PPIILLOOTT  AASSSSIISSTT  
Clicking this item opens a dialog box that allows you to control the Pilot Assist 

System, or the AFS. 
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The AFS helps you maintain a straight and level flight.  If the NexSTAR strays from 

level flight, you can return the gimbals to the center, or neutral, position and the AFS 

will automatically level the aircraft for you. 

To turn on the AFS, click the “Pilot Assist On” checkbox.  To adjust the sensitivity, 

move the slider from “less” to “more”.  If you are just beginning, start off further to 

the “more” side of the slider to increase the sensitivity.  As you become more 

comfortable flying, reduce it towards the “less” end of the slider.  The goal is to get 

to the point where you are comfortable flying without it on. 

 

RREESSEETT  PPOOSSIITTIIOONN  
Click on this item to reset the aircraft to the takeoff point.  You can accomplish the 

same task by pressing the keyboard’s space bar. 

The aircraft will automatically reset itself after a crash.  

KKIILLLL  EENNGGIINNEE  
Click on this item to stop the motor from running.  This is useful in practicing dead-

stick landings.  Alternatively, you may also press the keyboard “K”. 
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CCHHAAPPTTEERR  88..  TTHHEE  OOPPTTIIOONNSS  MMEENNUU  

OOPPTTIIOONNSS  MMEENNUU  OOVVEERRVVIIEEWW  
The Options menu controls several RealFlight program features. Items in this menu 

include:  

 

 Direct 3D… 

 Graphics Optimizations… 

 Run in Window 

 Virtual Flight Instructor… 

 Music/Sound… 

DDIIRREECCTT33DD  
Select this item to control settings for your 3D video card.   

 



RealFlight G2 NexSTAR Edition Simulator Chapter 8. The Options Menu    23 

 

CURRENT MODE 

This displays the current screen width, the height and the bits per pixel.  

Additionally, if your monitor’s current refresh rate is known, it will also be 

displayed. 

ADAPTER 

If you have more than one Direct3D compatible video card, they will both be listed 

here.  Please choose the card you wish to use for the simulation. 

RENDERING DEVICE 

Each card may offer different devices, although most cards will only offer the HAL 

interface. 

USE HARDWARE VERTEX PROCESSING IF AVAILABLE 

Check this box if you wish to use the hardware vertex processing.  Most of the time 

you want this option enabled.  If you experience difficulties with the graphics, try 

disabling this option.  If disabling this option fixes your problem, then contact your 

video card manufacture and notify them of this difficulty. 

You can look in the Graphics Optimizations dialog (See “Graphics Optimizations” 

on page 25 to see if your card supports Hardware Vertex Processing). 

RENDERING MODE 

The RealFlight NexSTAR Edition may operate in either Window mode, or in Full 

Screen Mode.   
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WINDOW MODE 

The Window mode screen size is dictated by the settings that you have selected in 

the Display Properties for your monitor.  If the simulation is run in the Window 

Mode, the RealFlight menus will always appear at the top of the screen for easy 

access.  It is possible to change the resolution of the desktop at any time by going to 

Start, Settings, Control Panel (appearance and themes), Display. 

Please note:  if you are using a 32 Bit Color display mode for your desktop, it will 

not render as quickly as choosing a 16 Bit Color display mode. 

FULL SCREEN MODE 

Selecting this option will allow RealFlight to use the entire monitor screen.  If you 

are running in Full Screen Mode, the RealFlight menus will not appear on the screen.  

To access the menu, press either the ESCape key or the ALT key on the keyboard.   

RESOLUTION  

In full screen mode only, you can use this control to adjust the screen resolution and 

color depth.  If your frame rate is unacceptably low, you can improve it by reducing 

the resolution or color depth.  This will reduce some of the rendering required of 

your video card.  

Resolution determines both the sharpness of the picture and how many colors will be 

used to render the picture.  To illustrate resolution, here is the same image of a plane 

at two different resolutions. 

 

 

640 x 400 Resolution 1600 x 1200 Resolution 

 

Notice how much clearer the higher resolution picture is.  On some computers, 

higher resolutions cause the program to run much slower.  Selecting the ideal 

resolution for your computer requires a delicate balance between quality and speed. 

REFRESH RATE 

This feature adjusts the refresh rate of your monitor (Full Screen Mode only).  

This controls only the refresh rate, not the frame rate.  

Refresh rate is the number of times per second that your monitor retraces its video 

display. Your video hardware (monitor and graphics card) dictates what refresh rates 

you can use.   
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Frame rate is the number of times per second that RealFlight creates a different 

picture to display on your monitor. Frame rate is determined by the speed of your 

CPU and graphics card, and how many RealFlight options are activated.   

Use this control to set the refresh rate for Full Screen Mode. If RealFlight is unable 

to determine what refresh rates your card supports, this control will display "0." 

Higher refresh rates have less "flicker” and usually cause less eye strain. 

For suggestions on increasing RealFlight's frame rate, see "Improving RealFlight 

Performance" on page 57. 

We suggest that you test a variety of resolutions and color options to achieve the 

optimum performance and setup for your system. 

 

GGRRAAPPHHIICCSS  OOPPTTIIMMIIZZAATTIIOONNSS  
Select this item to access the Graphics Optimizations dialog: 

 

This dialog controls a wide variety of the graphics performance options in the 

simulator.   

While RealFlight NexSTAR Edition attempts to optimize your system’s 

performance, these controls will enable you to further fine-tune the simulation to suit 

your personal taste. 

TEXTURE QUALITY SLIDER 

As the name suggests, this slider controls the texture quality of the simulator.  

Moving the slider to the right will increase the texture resolution.  Higher resolutions 

will improve the realistic appearance, but may also slow down the frame rate.  
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GRAPHICS QUALITY SLIDER 

This slider controls several graphics aspects of the RealFlight simulation (for 

example, shadow quality), allowing you to tweak the simulation for optimum 

performance.  Higher graphics quality will improve the realism, but may also slow 

down the frame rate. 

TERRAIN DENSITY SLIDER 

Increasing the values of the Terrain Density will increase the resolution of the terrain 

thereby giving it a more life-like appearance.  Higher resolution will improve the 

realism, but may also slow down the frame rate. 

USE MIPMAPS 

Click this check box to activate the MipMaps feature.  Turning this feature “off” may 

cause unwanted “sparkling” on distant objects, or on object surfaces that are viewed 

at large angles. Using MipMaps improves realism, but may slow down the frame 

rate. 

USE DETAIL TEXTURES 

Click this check box to use detailed textures at your flying site.  This increases the 

detail and sharpness on surfaces (the ground in particular).  Using the detailed 

textures feature improves realism, but may slow down the frame rate. 

USE SPECULAR HIGHLIGHTING 

Click this check box to use the Specular Highlighting feature.  This feature makes 

smooth objects appear shiny in reflected light.   Using the Specular Highlighting 

feature improves realism, but may slow down the frame rate. 

SHOW AIRPORT OBJECTS SHADOWS 

Click this check box to show the shadows that are cast by the airport objects such as 

buildings, walls, etc.  Using the feature improves realism, but may slow down the 

frame rate. 

SHOW TREE SHADOWS 

Click this check box to show the shadows that are cast by the trees.  Using the 

feature improves realism, but may slow down the frame rate. 

GRAPHICS CARD INFO 

This panel displays information pertaining to your graphics card.  This is an easy 

way to determine whether or not your current graphics card will support a certain 

feature or function. 

RRUUNN  IINN  WWIINNDDOOWW      
Select this item to determine whether the RealFlight NexSTAR Edition will run in 

the Window Mode or in Full Screen Mode.  If checked, RealFlight will run in the 

Window Mode.  If unchecked, the program will run in Full Screen Mode. 
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Please note, not all video cards support Full Screen or Windows Modes.  You may 

only use modes that your video card is capable of supporting.   

VVIIRRTTUUAALL  FFLLIIGGHHTT  IINNSSTTRRUUCCTTOORR  
Would you like to learn how to do a maneuver? With RealFlight NexSTAR Edition’s 

Virtual Flight Instructor feature, you’ll receive a personal flying lesson from a pro.     

Mike Cross, an airplane designer and two-time IMAC freestyle champion, will take 

you through the fixed wing maneuvers.   

When you select this item, the following dialog will appear: 

 

Select the maneuver that you wish to learn, and then click OK. RealFlight will show 

you a recording of the NexSTAR, piloted by Mr. Cross, performing the maneuver. 

During the maneuver you’ll hear the instructor’s voice instructing you how to do the 

maneuver. You can simultaneously watch the instructor’s stick movements on the 

onscreen radio gadget.     

When you are done, you can end the instruction by closing the Playback Gadget. 

VIRTUAL FLIGHT INSTRUCTOR GADGETS 

To close the gadget, click on the red “X” on the gadget’s title tab.  To move any 

gadget, drag by its title tab.  To resize the radio gadget drag the edge of the gadget. 

 

The list of gadget items is as follows: 

 

Gadget Preview 

Flight Playback Gadget lets 

you control the playback of a 

Virtual Flight Instruction. 
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Radio Gadget lets you view 

the stick movements of the 
instructor’s transmitter.  

 

FLIGHT PLAYBACK GADGET 

The Flight Playback gadget lets you easily control the playback of the VFI lessons 

using simple mouse clicks. It features VCR-like controls that start or pause playback, 

speed up or slow down playback speed, etc. 

 

SELECT RECORDING  

Although not applicable to the NexSTAR Edition software, if you were running 

more than one recording, select the recording you wish to control by clicking on the 

gadget's up or down arrows. The number on the gadget will increase or decrease; this 

number indicates the list number of the recording the gadget is currently controlling. 

Once you have selected the recording you want to control, click on the gadget's 

buttons to control the recording.  

Again, this option is not active on the RealFlight NexSTAR Edition software. 

LOOP PLAY   

The arrows that form a circle are used to loop the recording (i.e., continuous play). 

LOOK AT RECORDING  

Click on the “eye” to start the playback.  Clicking on the “eye” will cause it to 

illuminate.  As long as the eye is illuminated, you will continue to view the current 

recording.  If you have multiple recordings playing simultaneously, and wish to look 

at a different recording, click the up/down arrow while this “eye” is illuminated. 

PAUSE  

The "II" button pauses playback if the recording is playing.  After you have paused, 

click this button once again to play the recording.  This button will be illuminated 

when the pause feature has been activated. 

POSITION OF RECORDING  

Use the slider control to choose the portion of the recording you wish to view. In 

other words, you can have the recording playback start in mid-recording, or end in 

mid-recording. Drag the lower arrow to set the playback start point, and the right 
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arrow to set the playback end point. As you play the recording, the top arrow tracks 

to show you what playback time segment you are currently viewing. You can set to a 

different playback segment by dragging the top arrow. 

PLAYBACK SPEED  

The number on the far right side is the speed at which the playback will occur.  You 

can adjust the playback speed by clicking on the up/down arrows next to the number. 

To increase playback speed, click on the up arrow.  To reduce playback speed, click 

on the down arrow.  You can use this when you’re learning a maneuver from a 

recording—adjust the playback speed to watch the maneuver in slow motion. 

RADIO GADGET   

If this selection is checked, the onscreen transmitter will appear.  This transmitter 

offers a digital recreation of the transmitter onscreen.  This digital transmitter mimics 

the stick input in real-time.  The radio gadget always shows the stick inputs.  This 

serves as a visual aid in the training process and an onscreen reminder for the proper 

stick inputs. 

 

 

MMUUSSIICC//SSOOUUNNDD  
Music and sound effects add another dimension to your simulation experience.  You 

can choose to fly to background music or you can listen to the ambient sounds of a 

local flying field.  If you want some random “jeering,” then turn on the random 

effects.  If you have a slow sound card or a slow machine, you may not be able to 

turn “on” all of the sound effect options. 
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PLAY ENGINE SOUNDS 

Select whether or not to play the engine sounds.  Engine sounds are an important part 

of the simulation; providing you with an audible indication of the NexSTAR’s speed 

and distance.   

You will appreciate the Doppler- correct engine sounds as your NexSTAR goes 

screaming by you! 

ENGINE SOUNDS VOLUME SLIDER 

Use this slider to adjust the sound level of the engine. 

USE VIRTUALREVOLUTION TECHNOLOGY 

VirtualRevolution engine technology makes the engine sound correct at both idle and 

full power and everywhere in between.  This sounds the best, but requires more 

computer memory and will slow down the frame rate on slower computers.   

PLAY BACKGROUND MUSIC 

Select whether or not to play the CD-quality background music.  This can slow down 

the rendering speed.  Use this option only if you have a fast computer. 

MUSIC VOLUME SLIDER 

This slider is used to adjust the sound levels of the background music in the 

simulation.   

PLAY LIST 

Select which songs and ambient background tracks to play.  Highlight songs on the 

play list to turn them “on.”   



RealFlight G2 NexSTAR Edition Simulator Chapter 8. The Options Menu    31 

RANDOM EFFECTS SLIDER 

This slider displays the frequency of the "random" sound effects.  Adjust the slider to 

make them occur as in/frequently as you would like.  

RANDOM EFFECTS VOLUME SLIDER 

This slider displays the volume of the Random Effects.   

PLAY CRASH SOUNDS 

Select whether or not to play the crash sounds when the NexSTAR crashes. 

PLAY DIALOG SOUND EFFECTS 

Select whether or not to play the sound effects while navigating the dialogs. 

PLAY WIND SOUNDS 

Select whether or not to play the wind sounds when wind is enabled. 

USE SOFTWARE MIXING 

This box indicates whether to use the CPU or the Sound Card to mix the audio.  By 

turning on Software Mixing, you force the CPU to do the mixing; this may be a little 

slower, but may sound better. 
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CCHHAAPPTTEERR  99..  TTHHEE  VVIIEEWW  MMEENNUU  

VVIIEEWW  MMEENNUU  OOVVEERRVVIIEEWW  
The View menu controls all options and settings for views. The term Views describes 

what you are looking at, and how you are looking at it.    

When you open the pull-down View menu, you will see the following items: 

 

 

 Binocular View 

 Zoom Reset 

 Zoom In 

 Zoom Out 

 Look at My Aircraft 

 Look at Wind Sock 

 Look at Ground 
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BBIINNOOCCUULLAARR  VVIIEEWW  
The binocular view is used to maintain a constant zoom level.  This view is 

particularly useful for observing an aircraft’s orientation when it is far away. 

ZZOOOOMM  RREESSEETT        
This selection resets the zoom magnification level.  This is useful if you are zoomed 

way in or way out and want to return quickly to the default level of magnification  

You can also reset the zoom level by pressing the “F1” key.  

ZZOOOOMM  IINN  
This selection will zoom in on the NexSTAR.  Alternatively, the “F2” key has the 

same effect.  RealFlight will incrementally zoom in on the NexSTAR each time the 

function key: “F2” is pressed or Zoom In is selected. 

ZZOOOOMM  OOUUTT  
This selection will zoom out from the NexSTAR incrementally.  Alternatively, each 

time the “F3” key is pressed the program will zoom out, incrementally, from the 

NexSTAR, thus giving a larger perspective of the area surrounding your airplane. 

LLOOOOKK  AATT  MMYY  AAIIRRCCRRAAFFTT    
Select this option to look at the NexSTAR that you are piloting.  Alternatively, you 

may press the “F9” key. 

LLOOOOKK  AATT  WWIINNDD  SSOOCCKK  
Select this option to look at the wind sock instead of your airplane.  To stop looking 

at the wind sock and return to viewing your airplane, select Look at My Aircraft 

(described above). 

Pressing the Left Arrow key on your keyboard will briefly change the view to look at 

the wind sock and then move back to viewing the NexSTAR. 

LLOOOOKK  AATT  GGRROOUUNNDD  
Select this option to look at the ground beneath the viewpoint option.   This selection 

will always retain the ground in the vantage point.  This is helpful in altitude 

orientation.  To turn off this option, select Look at My Aircraft (described above). 

For a temporary look at the ground, press the Down Arrow key on your keyboard.  

This will briefly change the view to include the ground before switching back to the 

default view of your airplane. 
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CCHHAAPPTTEERR  1100..  TTHHEE  HHEELLPP  MMEENNUU  

HHEELLPP  MMEENNUU  OOVVEERRVVIIEEWW  
Should you experience any difficulties (or just want to find out more about 

RealFlight NexSTAR Edition and its features), the Help menu has several resources 

to assist you. When you open the pull-down menu, you will see several options:  

 

 Contents… 

 Technical Support… 

 Credits… 

 Slide Show… 

 RealFlight on the Web 

 Online Updates… 

 About… 
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CCOONNTTEENNTTSS  
This opens up RealFlight’s help files. The help files contain information similar to 

this manual. 

TTEECCHHNNIICCAALL  SSUUPPPPOORRTT  
If you should have any difficulties running RealFlight, consult this item. You can 

access online troubleshooting information, or contact our technical support staff. 

CCRREEDDIITTSS  
Select this item to see the names of some of the people who contributed to the 

RealFlight NexSTAR Edition. 

SSLLIIDDEE  SSHHOOWW  
The slide show is designed to provide you with a brief overview of the full 

RealFlight G2 software.  The complete version of the software offers many, many 

exciting options, features and functions that are not found in the NexSTAR Edition.   

RREEAALLFFLLIIGGHHTT  OONN  TTHHEE  WWEEBB  

REALFLIGHT WEB SITE 

This is the main web site for all RealFlight software. 

See it now: http://www.realflight.com 

GREAT PLANES WEB SITE 

This is the web site for Great Planes, the publishers of RealFlight. 

See it now: http://www.greatplanes.com 

KNIFE EDGE SOFTWARE WEB SITE 

This is the web site for Knife Edge Software, the developers of RealFlight. 

See it now: http://www.knifeedge.com 

GP SOFTWARE SITE 

Visit this site for information about our software products, including RealFlight 

NexSTAR Edition and RealFlight G2. The site includes our online product 

Knowledge Base. This is the same problem-solving database our product support 

staff uses to help RealFlight owners resolve difficulties. 

See it now: http://www.gpsoftware.com 

http://www.gpsoftware.com/
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OONNLLIINNEE  UUPPDDAATTEESS  
This menu launches the RealFlight Control Panel.  See “Appendix B. RealFlight 

Control Panel” on page 42. 
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CCHHAAPPTTEERR  1111..  UUSSIINNGG  TTHHEE  KKEEYYBBOOAARRDD  

TTOO  AACCCCEESSSS  RREEAALLFFLLIIGGHHTT  CCOOMMMMAANNDDSS  

KKEEYYBBOOAARRDD  MMAAPPPPIINNGG  ((HHOOTT  KKEEYYSS))  
RealFlight allows you to access menu and other commands from your computer’s 

keyboard. A key that invokes a command is called a quick key or hot key.  These 

keys provide a quicker way of accessing functions or features.   

For example, pressing the “F2” key incrementally zooms your view towards the 

aircraft. This is exactly the same result that arises if you select Zoom In from the 

RealFlight View menu. Consequently, we say that “F2” is a hot key for the Zoom In 

command. 

Please note when a particular menu has a hot key, it will appear to the right of the 

menu selection. 
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KKEEYYBBOOAARRDD  MMAAPP    
The table below contains a list of every key that is assigned to a RealFlight 

command. Alongside, you can find the default mapping for this key.  

  

Assignable 

Keys 

Default Mappings Where to find information on this 

command 

Down 

Arrow 

Look at Windsock "Look at Wind Sock" on page 33 

Left Arrow Look at Ground "Look at Ground" on page 33 

K Aircraft: Kill Engine “Kill Engine” on page 21 

T Show Trees "Show Trees" on page 18 

V Virtual Flight 

Instructor 

“Virtual Flight Instructor” on page 27 

W Weather Conditions  

F1 View: Zoom Reset “Zoom Reset” on page 33 

F2 View: Zoom In “Zoom In” on page 33 

F3 View: Zoom Out “Zoom Out” on page 33 

F9 View: Look at my 

Plane 

“Look at My Aircraft” on page 33 

Space bar Aircraft: Reset Position “Reset Position” on page 21 

Tab Run in Window "Run in Window" on page 26 
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AAPPPPEENNDDIIXX  AA..  FFLLYYIINNGG  TTHHEE  AAIIRRCCRRAAFFTT  

AAIIRRPPLLAANNEE  BBAASSIICCSS  

CENTERING 

Trim tabs are the small slider controls on the controller (two per controller stick). 

They are used to “trim” the aircraft so that it flies straight and level.  For example, if 

an airplane has a tendency to veer slightly downward, you may need to add a slight 

“up” nudge to the elevator trim. You can do this by sliding the elevator trim, a click 

or two at a time, towards the bottom of the controller.  

 

CCRRAASSHHIINNGG  
While takeoffs are optional, landings are mandatory.  Successful landings are a 

crucial skill to master.  

The key to a perfect landing is undivided concentration.  Pay close attention to the 

altitude of the aircraft as well as its orientation to the runway.  Use each crash as a 

learning experience to perfect your approach and the landing itself. 

RealFlight includes several tools to help you during the approach and landing.  See 

“Landings” below for ideas. 

 

AAIIRRPPLLAANNEE  FFLLIIGGHHTT  
RealFlight recreates the flight characteristics of the NexSTAR, allowing you to 

practice your R/C flying without worrying about expensive crashes.  Additionally, 

RealFlight is ideal for practicing new maneuvers and experimenting.  It is important 

to remember, however, that a simulator will only help you learn to fly if you let it.  

Otherwise, it is just a game.  Learning to fly R/C aircraft requires a commitment.  

One doesn’t just grab the sticks and start dazzling the crowds.  A methodical, patient 

approach will help you get the most out of this simulator. 

This section is not designed to teach you how to fly. Rather, it will help you enhance 

your experience with the simulator.  
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TAKEOFFS 

When you are taking off, start with the throttle in low position and slowly increase 

the throttle by pushing the throttle stick away from you towards the top of the 

transmitter until you are at about half speed. Stay in the middle of the runway (you 

can steer the plane using the rudder).  When you have built up enough speed, you 

can climb off the runway by gradually pulling back on the elevator. If the plane is 

tracking well, apply the rest of the power more quickly, climbing out and gaining 

altitude.   

Be careful not to veer off the runway. In a real plane, chances are you would crash 

(or get stopped on the grass). Usually this means a bent landing gear and broken 

prop. 

LANDINGS 

It is very important to land on the runway, rather than veering off, or touching down 

before you reach the runway. Either of the latter usually produces a moderately 

expensive crash. If you “cartwheel” (wing tip hits the ground), the wing can break, 

resulting in lengthy down time. 

Start by aligning your plane with the runway. Fly the approach normally, using your 

throttle to control the rate of descent. Try to land at the slowest speed possible. As 

you touch down it is important to keep the NexSTAR’s nose up! 

RealFlight has several tools to help you practice landings.  

 Before you try to land yourself, you may want to review the process 

with the Virtual Flight Instructor. In the Options menu, select “Virtual 

Flight Instructor”; when a dialog appears, select the “Touch and Go” 

lesson.  

 You can also activate the Look At Ground feature. In the View menu, 

select “Look at Ground.” This option will cause the simulator to always 

keep the ground in perspective, regardless of aircraft location.    

THROTTLE MANAGEMENT 

Avoid the temptation of giving the plane full throttle and keeping it there for hours at 

a time. This teaches you bad habits and makes even a good flier look like a rookie 

out at the field. 

RUDDER MANAGEMENT 

Planes can, more or less, effectively be flown with just the elevator and ailerons.  

But, good pilots will tell you that rudder is just as important.  Many aerobatic 

maneuvers require excellent rudder usage. 

Rudder control is especially important when landing in a crosswind.  Pilots that 

cannot use the rudder usually land in the tall grass (embarrassing!).  Pilots that do 

use the rudder can land on the numbers almost every time. 

TAKE CRASHES SERIOUSLY 

Out at the field a crash might result in one or more of the following: 
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 Bruise your ego 

 End flying for the day 

 Cost you money 

 Cost you time to rebuild 

 Even win you a nice “best crash trophy!” 

Of course, when you crash on the simulator, there is really no harm done.  None, that 

is, except the bad habits you can learn. Take the crashes seriously.  Learn from each 

one and you will be a better pilot out at the field. 
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AAPPPPEENNDDIIXX  BB..  RREEAALLFFLLIIGGHHTT  CCOONNTTRROOLL  

PPAANNEELL  

RREEAALLFFLLIIGGHHTT  CCOONNTTRROOLL  PPAANNEELL  
The RealFlight Control Panel is a separate application, designed to work in 

conjunction with RealFlight NexSTAR Edition. 
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RUNNING THE CONTROL PANEL 

There are three ways to run the RealFlight Control Panel. 

 Insert the CD into the drive.  If Auto-Play is active, then the RealFlight 

Control Panel will start on its own. 

 If RealFlight is already installed, click the Start button in the Windows 

Task Bar. In the Start menu, select Programs/RealFlight/RealFlight 

Control Panel. 

 If RealFlight is already running, choose “Online Updates…” from the 

Help menu. 

RUNNING REALFLIGHT 

To start running RealFlight, press the Run RealFlight button on the Control Panel.  

(Note: if RealFlight is already running, the Control Panel will not let you start up a 

second RealFlight window.) 

UNINSTALLING REALFLIGHT 

To Uninstall RealFlight, press the Uninstall RealFlight Button.  The following 

dialog will appear: 

 

If you choose to uninstall using the “Add/Remove Programs” feature in Windows, it 

will start the RealFlight Control Panel.  Just press the Uninstall RealFlight button as 

mentioned above.  Uninstalling via the RealFlight Control Panel will ensure that all 

necessary RealFlight files are removed. 

UNINSTALL PROGRAM 

Choose this option to uninstall only the RealFlight program itself.   

REMOVE SERIAL NUMBERS 

Choose this option to remove all RealFlight serial numbers from your system. 

REMOVE CACHED FILES 

Choose this to option to remove all cached download files from your system.  If you 

uninstall these files, future downloads may take a little longer. 
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READ HELP FILE 

Press the Read Help File button to bring up the help file for RealFlight. 

 

TECHNICAL SUPPORT 

Press the Technical Support button to bring up technical support information about 

your system.  If you encounter any problems with RealFlight, this information can 

help you to resolve it on your own, or can help Great Planes’ Support Staff to rapidly 

diagnose the problem. 

 

SYSTEM INFORMATION 

This displays a list of the critical system information.  Before you email technical 

support, or report a bug with the software, please be sure to cut and paste this 

information into your email. This will be of great assistance to them in diagnosing 

the difficulty.  

DX EXAMPLES 

Press these buttons to run sample DirectX programs written by Microsoft. They are 

very basic programs that test your DirectX installation and hardware.  If these 

samples don’t run correctly, then your problem lies either with your DirectX 

installation, or with your hardware drivers (usually video or sound).   

To resolve these problems you should first contact your video/sound card 

manufacture for updated drivers. This is very important. Card manufacturers 

frequently update their drivers to fix problems that arise. Even if you have just 
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purchased a new computer system there may be a more recent driver available for 

download. 

If you are sure you have the latest drivers, you may need to reinstall DirectX, or 

update your version. 

REINSTALL DIRECTX 

This option reinstalls Microsoft’s DirectX.  Occasionally this will fix corrupted 

installations. 

ASSEMBLE SYSTEM INFORMATION 

This option collects critical information about your system, and about your 

RealFlight settings. You may find this information useful if you try to troubleshoot 

problems on your own. Moreover, if needed you can cut and paste this information 

into an email to Great Planes Technical Support. When you use the online 

registration to register RealFlight, this is the hardware information that is sent to 

Great Planes. 

 

ENTER TECHNICAL SUPPORT CODE 

Choose this option to enter a technical support code. If you encounter difficulties 

running RealFlight, our Technical Support team may supply you with a support code 

to input. Entering this code will assist them in diagnosing or resolving your 

difficulty.  
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VIEW WEB TECHNICAL SUPPORT 

Choosing this option will open a browser window, and take you to a web site that 

contains the most up-to-date technical support information for RealFlight NexSTAR 

Edition. 

EMAIL TECHNICAL SUPPORT 

This provides you with the address (rfnexstar@greatplanes.com) to which you can 

email your difficulties.  If you do email us, please be sure to include the Assemble 

System Information output in your email. 

VIEW TASKS 

This displays a list of all tasks running on your PC.  Some tasks can interfere with 

RealFlight and may need to be closed.  Our Technical Support team will be glad to 

help you close problem tasks. 

DX DIAGNOSTICS 

This brings up Microsoft’s DirectX Diagnostic Tool.  Using this utility can further 

help diagnose your system. (Important: if you send us information about your system 

to help us diagnose a difficulty, please do not use DXDIAG to generate that 

information. Instead, please use the “Assemble System Information” feature [see 

above]. The “Assemble System Information” output file contains more information 

than the DXDIAG output. 

 

MSINFO 

This option will run MSInfo.  This will give you even more information about your 

system. This program is not always installed on your computer, but normally comes 

with programs such as Microsoft Office®. 

mailto:rfnexstar@greatplanes.com
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DISPLAY PROPERTIES 

This brings up your monitor’s display properties. You can use this page to change 

the resolution of your desktop. 

 

EXPLORER 

This button launches Windows Explorer. This Microsoft Windows utility can help 

you locate, move and backup your files. 
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LAUNCH DEVICE MANAGER 

This button launches the Device Manager. This Microsoft Windows utility will help 

you determine driver dates, as well as installing and updating video and sound card 

drivers. 

 

 

 

 



RealFlight G2 NexSTAR Edition Simulator Appendix B. RealFlight Control Panel    49 

VIEWING DOCUMENTS 

This lets you view important documents that come with RealFlight. 

OONNLLIINNEE  UUPPDDAATTEESS  
We are proud to bring you a cutting edge way of updating RealFlight NexSTAR 

Edition.  You can download and install the latest version with a single button click. 

 

 

REGISTRATION 

By registering the program you are eligible for Free online updates and technical 

support.  
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Please enter the necessary information.  If you forget your password, contact Great 

Planes Support.  To do so, email them at rfnexstar@greatplanes.com or telephone 

them at 217-398-8970 (option #1).  They will confirm your identity, and issue you a 

new password. 

HARDWARE INFORMATION 

If you leave the “Send Hardware Information” box checked when you register 

RealFlight automatically transmits information pertaining to your system hardware 

and settings.  

This information will assist us in rapidly diagnosing any difficulties you may 

encounter, should you need to contact Technical Support. As such, we suggest that 

you leave this box checked when registering. 

This is entirely optional. If you uncheck the box, the registration RealFlight will not 

send any information about your system. Additionally, you can view the information 

RealFlight will send us before you decide. To view this information, click the 

Technical Support button on the RealFlight Control Panel. When the Technical 

Support page appears, click Assemble System Information. 

UPDATING TO THE LATEST VERSION 

After registering (you only need to register once), you can update to the latest 

version.  This will download all necessary files and automatically install the update. 

mailto:rfnexstar@greatplanes.com


RealFlight G2 NexSTAR Edition Simulator Appendix B. RealFlight Control Panel    51 

CHECK FOR LATEST UPDATES BEFORE RUNNING REALFLIGHT 

If you check this box, then every time you run the RealFlight Control Panel, the 

system will check to see if there is a more recent version of RealFlight available.  If 

so, the Control Panel will then ask you if you want to download and install it.  Note: 

In order to do so, your PC must be connected to the Internet. 

ADVANCED OPTIONS 

UPDATE TO SPECIFIC VERSION 

If you experience difficulties with any version, you can actually go backwards and 

retrieve a previous version.  If the previous version fixes your problem, please 

contact our technical support team at rfnexstar@greatplanes.com and let them 

know about the problem encountered. 

 

CLEAR DOWNLOAD CACHE 

Occasionally files will become corrupted on download.  If you are experiencing 

difficulties with the Online Updates, try removing all cached files using this option.  

Next, choose Update to Specific Version and select the Completely Refresh 

option. 

mailto:rfsupport@greatplanes.com
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PROXY SETTINGS 

 

If you are behind a firewall that restricts FTP access, you may need to change the 

proxy settings in order for RealFlight to get the latest updates. Most home users will 

keep the Proxy Server OFF. 

If you do need to use the proxy server, contact your network administrator to 

determine the appropriate settings. 

PROBLEMS UPDATING? 

Here are some possible problems that might occur when updating. 

BAD INTERNET CONNECTION 

 

You either don’t have access to the Internet, or the FTP server is unavailable.  

Attempt to connect directly to the Internet using your browser.  If you are behind a 

proxy server, then adjust the proxy settings. 

SERVER UNAVAILABLE 

 

The server may be down or may be overloaded.  Please try again later.  If this 

problem persists, contact technical support for further information. 
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AAPPPPEENNDDIIXX  CC..  IIFF  YYOOUU  EEXXPPEERRIIEENNCCEE  

DDIIFFFFIICCUULLTTIIEESS  WWIITTHH  RREEAALLFFLLIIGGHHTT  ……  

IINN  GGEENNEERRAALL  
This simulator is on the cutting edge of technology, and runs using advanced 

hardware.  Consequently, there is always the possibility you may experience some 

difficulties. Should the need arise, we provide extensive resources to help. 

In addition to providing the best R/C simulator, we sincerely feel that we provide the 

best, most extensive product support for any R/C simulator. Since cards, drivers, 

operating systems, etc. are always changing, we work hard to keep our support up to 

date on the latest issues and difficulties RealFlight users might encounter. 

This section starts with a summary of the various sources of RealFlight information, 

support, and problem solving assistance. Then, we’ll show you some simple but 

powerful steps that can resolve or prevent most RealFlight difficulties. Finally, if 

these steps don’t solve your problem, we’ll show you the most effective ways to 

acquire additional assistance. 

HOW TO GET HELP AND INFORMATION 

As a RealFlight NexSTAR Edition user, you have access to an incredible amount of 

information about this product. Much of this information will help you resolve 

problems, or correctly access and use program features. Here’s where you can find it: 

 The manual. You can solve most common RealFlight problems by 

following the instructions in later sections of this chapter. Additionally, 

other manual chapters explain RealFlight NexSTAR Edition’s features 

in greater detail.  

 Online Help. You can access all of this manual’s material directly 

from RealFlight’s Help menu. This help file is indexed and searchable. 

 Visit our product Knowledge Base at http://www.gpsoftware.com. 

This great resource is an indexed, searchable collection of articles that 

described solutions to almost every known problem with RealFlight, 

RealRace, and all our other software products. This is the very same 

http://www.gpsoftware.com/
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information database that our product support technicians refer to when 

assisting customers.  

 Visit the home page of Knife Edge Software, the makers of RealFlight, 

RealRace and other R/C simulation products or access the  Message 

Boards through http://www.knifeedge.com. This is a place where 

owners of RealFlight, RealRace, and other Knife Edge products post 

questions, comments and responses. Sometimes our product support 

technicians, and product developers from Knife Edge, post replies and 

announcements as well.  

 Contact our Product Support department by email at: 

rfnexstar@greatplanes.com or by phone or postal mail at: 

RealFlight Product Support 

3002 North Apollo Drive 

Suite 1 

Champaign, IL 61822 

Voice phone: (217) 398-8970 (Option #1) 

FAX phone:  (217) 398-7721 

They are specially trained, and have a lot of resources, to help you 

resolve problems with RealFlight. 

BEFORE YOU DO ANYTHING ELSE… 
  

Should you experience any difficulties with RealFlight, try the steps below prior to 

contacting Software Support. These steps really do cure most problems our users 

experience. Even if you aren’t having a problem, these same steps often help make 

RealFlight, and your computer, work better. 

Here are the steps you should take (instructions for each step follow): 

 Update your video and sound card drivers (see instructions below).  

 Update to the latest version of RealFlight. 

 If the problem persists, run the DirectX test programs. 

 If these steps don’t work, read on to the next section. 

Update Your Drivers 

Before you do anything else, you should make sure you have updated your video and 

sound drivers. A large number of problems encountered by RealFlight users can be 

cured by updating drivers. 

A driver is a software program that controls your video or sound card. Each card 

manufacturer provides drivers for its own cards. To work correctly, RealFlight relies 

on these video and sound card drivers to function properly.  

It is very important to use the latest driver available for your card. Card 

manufacturers frequently release updated drivers to fix problems that occur when the 

driver is used with programs such as RealFlight. The drivers that came with your 

new computer, or on your Windows CD, or on a CD included with the new card you 

bought, may not be the latest version. 

If you don’t know how to update drivers, you can find instructions in our Knowledge 

Base article Q01-1038, How to Update Drivers, at 

mailto:rfnexstar@greatplanes.com
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http://www.gpsoftware.com/kb/q01-1038.htm. This page will take you through the 

process step-by-step, and has links to driver download sites for most manufacturers. 

Update to the Latest Version of RealFlight  

As we regularly release program updates, the difficulty that you are seeing may 

already be fixed in an update. 

To update, use the RealFlight control panel (see "Appendix B. RealFlight Control 

Panel" on page 42. 

Run the DirectX Test Programs 

If you have updated your drivers and RealFlight to the latest versions, and your 

problem persists, you should try to run the DirectX samples that come with 

RealFlight. 

The DirectX samples (Billboard, Sound, etc.) are test programs written by 

Microsoft. These samples ship with DirectX, and are designed to check whether your 

DirectX installation, video/sound cards and drivers, etc., are working correctly. They 

should work on any DirectX 8.1 compliant driver. 

You can run the samples using the RealFlight Control Panel. Open the Control Panel, 

click “Technical Support,” and then look for the “DX Examples” box. Click a button 

to run a sample program. 

The most important sample is Billboard, which tests your video card and driver. If 

you are having any graphics difficulty in RealFlight (including RealFlight “freezing” 

your system so that you have to reboot), look for the same problem in Billboard. If 

the problem occurs only after you have run RealFlight for a period of time, make 

sure to run Billboard for a comparable length of time. 

If your RealFlight problem also occurs in Billboard, the problem lies with your 

video driver and not RealFlight. To resolve the problem, try finding updated drivers 

for your card (see above). If the problem still occurs with the latest drivers, you will 

need to report this problem to the card manufacturer. Be sure to tell them that you 

tested the card by using Billboard. Please note: in some cases, a newer video driver 

may have more problems than a previous version. After exhausting all other options, 

you might try obtaining an older driver from the manufacturer to eliminate this 

possible cause as well. 

If These Steps Don’t Work… 

If the steps above don’t work, please read on to the next section. 

IF YOU NEED ADDITIONAL ASSISTANCE… 

You’ve updated drivers, updated RealFlight, and your system successfully runs the 

DirectX sample programs, and you are still having problems. What next? 

First, check our knowledge base at http://www.gpsoftware.com. This is an easy to 

use, searchable, browsable database of known problems and solutions for RealFlight, 

RealRace, and our other software products. This is the same database that our 

Product Support technicians use when assisting customers. We are constantly 

updating the knowledge base to address new difficulties as we discover them. In 

many cases you will be able to find an article that gives clear, concise instructions 

for resolving your difficulty. 

You may also want to check the Knife Edge Discussion Boards at 

http://www.knifeedge.com. This is a place where owners of RealFlight, RealRace, 

http://www.gpsoftware.com/kb/q01-1038.htm
http://www.gpsoftware.com/
http://www.knifeedge.com/
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and other Knife Edge products post questions, comments and responses about 

problems. You may find a discussion thread about the difficulty that you are 

experiencing. 

You can also contact Product Support at Great Planes via email at: 

rfnexstar@greatplanes.com  

IMPORTANT. If you do contact Product Support, it is of great assistance if you 

provide detailed information about your computer system. Since your problem may 

only occur on a particular video or sound card, particular driver version, etc., we may 

need this information to help us diagnose your problem. To get your system 

information, use the RealFlight Control Panel.  In the control panel, click the 

Technical Support button, followed by the Assemble System Information button. 

This will create a file called “c:\cpaneloutput.txt”, which contains your system 

information. Attach this file to our email.  Alternatively, you may paste this 

information within the body of the email. 

EEXXAAMMPPLLEESS  OOFF  CCOOMMMMOONN  PPRROOBBLLEEMMSS  AANNDD  SSOOLLUUTTIIOONNSS  
 

IF YOU DON’T SEE YOUR PROBLEM IN THIS CHAPTER… 

This chapter contains a few examples of common difficulties and concerns that 

RealFlight users have experienced.  

Remember that we can never provide a complete list of problems and solutions in a 

program manual. RealFlight--and the computers, cards and drivers it uses--are 

constantly evolving. As such, we maintain a detailed Knowledge Base at 

http://www.gpsoftware.com. By keeping our Knowledge Base online, we can 

provide you with the latest information about resolving problems that RealFlight 

users are currently experiencing. If you don’t see your difficulty described in this 

chapter, please check the Knowledge Base. 

In this chapter, we’ve simply tried to pick a very short list of the most asked about 

issues. 

MY COMPUTER “FREEZES” WHEN I RUN REALFLIGHT, AND I NEED TO 

REBOOT TO REGAIN CONTROL. 

Sometimes, you may also notice sound skipping or repeating, or a computer reboot 

while flying. To resolve this type of problem, you must update the drivers for your 

video and sound cards. This is very important. Card manufacturers regularly update 

their drivers to fix this type of problem. Even the driver that came with your new 

computer may not be the most recent. 

Sometimes a card manufacturer will offer a choice between a “recommended” 

driver, and another driver (also called “special purpose”, “alternate”, or “beta” 

driver). If RealFlight “freezes” with the “recommended” driver, try using an alternate 

driver instead. 

If you are sure you are using the latest drivers, and have followed all the other steps 

in the previous section (update RealFlight, test DirectX) and are still having 

difficulty with your computer locking up while running RealFlight, please contact 

Great Planes Technical Support. 

mailto:rfnexstar@greatplanes.com
http://www.gpsoftware.com/
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IMPROVING REALFLIGHT PERFORMANCE 

During installation, RealFlight analyzes your computer’s hardware specifications. 

RealFlight then tries to optimize its configuration to best take advantage of that 

hardware, and achieve the best possible performance. 

However, if the performance is less than you’d expect, you can adjust some of 

RealFlight’s settings to improve the simulation speed and frame rate: 

 Ensure that the drivers for the video and sound cards are up-to-date.  

 Turn off all other programs, especially virus checkers and network 

applications (such as Instant Messengers) while running RealFlight.  

Use CTRL-ALT-DELETE to ensure that nothing else is running in the 

background.   

 Run the simulation in Full Screen Mode (in the Options menu, 

uncheck the Run in Window option). Alternatively, if you are running 

in Window Mode (Run in Window option is checked), alter the screen 

resolution from 32-bit to 16-bit color.  Also, decrease the size of the 

RealFlight window. 

 Reduce the texture quality.  This can have a profound effect on cards 

that do not have a high texture memory.  You can adjust texture quality 

on the Graphics Optimization page (See "Graphics Optimizations" on 

page 25.)  

 Eliminate the Airport Objects Shadow using the Graphics 

Optimizations page (See “Graphics Optimizations” on page 25)  

 Eliminate the Detail Textures using the Graphics Optimizations page 

(See “Graphics Optimizations” on page 25)  

 Reduce the number of open Gadgets.  Click the “X” on each Gadget 

that you wish to close. 

 Disable the trees.  In the Airport menu, uncheck the Show Trees 

option (this will make all trees and foliage disappear from your flying 

field). (See “Show Trees” on page 18) 

OTHER COMMON PROBLEMS 

Here are some other things you may want to keep an eye out for. 

 Check the CD-ROM for scratches or blemishes. Even minor scratches 

or fingerprints can cause random problems that appear to be program 

bugs. 

 Make sure your hard drive has at least 30MB of space available. To 

check this: 

1. Double click on the “My Computer” icon on your desktop; 

2. Right click on your main hard drive (usually drive “C:”); 

3. When a popup menu appears, select “Properties”; 

4. In the dialog that appears, view the amount of space available on 

the drive. 

If you need additional space, try emptying the Recycle Bin. 
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 Ensure that all other programs are closed prior to starting RealFlight.  

RealFlight works best when it is the only program running. 

 If all else fails, try rebooting your computer.  Occasionally, Windows 

(particularly 98 and ME) may become unstable after continuous use. A 

simple reboot may clear up any difficulties. 

 Ensure that your computer is running in at least 16-bit color resolution. 

You can verify this by right clicking on the Windows desktop and 

selecting “Properties”.  Then, click on the “Settings” tab and check the 

color palette box. 
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GGLLOOSSSSAARRYY  OOFF  TTEERRMMSS  

3D Acceleration 

3D operations require huge amounts of calculations.  Modern video cards offload 

many of these calculations to the card, rather than performing the calculations 

directly on your computer's CPU.  This speeds up the simulation and allows for 

faster frame rates, thereby increasing the realism of the simulation. 

AFS 

This is the Pilot Assist Link Auto-Pilot System, the device that is used to assist 

entry-level pilots in achieving R/C success.  Optical sensors read the difference 

between light (sky) and dark (horizon), then automatically adjust pitch and roll to 

stabilize the plane.  

Aileron 

Hinged control surfaces located on the trailing edge of the wing, one on each side, 

which provide control of the airplane about the roll axis. The control direction is 

often confusing to first time modelers. For a right roll or turn, the right hand aileron 

is moved upward and the left hand aileron downward, and vice versa for a left roll or 

turn.  

Airfoil 

This is the cross-section shape of a surface (e.g., wing) that produces lift.  Airfoils 

usually have some sort of a "tear drop" shape. 

Auto-Play 

Automatically detects when a CD-ROM is inserted and runs the specific program on 

the CD-ROM. 

Bilinear Textures 

Smoothes textured pixels together.  This can cause a blurry appearance but can also 

improve the overall appearance. 
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CG 

CG is the abbreviation for the phrase Center Of Gravity.  This is the point at which 

the airplane balances fore to aft, and side-to-side. The location of this point is crucial 

to how the airplane reacts in the air. A tail-heavy plane will be very snappy, but 

generally unstable and susceptible to more frequent stalls. Conversely, a nose-heavy 

airplane will tend to track better and be less sensitive to control inputs, but will 

generally drop its nose when the throttle is reduced to idle. This makes the plane 

more difficult to land, since it takes more effort to hold the nose up. A nose heavy 

airplane will have to come in faster to land safely.  

Collision Detection 

The collision detection feature senses when the aircraft “bumps” into an object, and 

causes a crash.  

Control Panel 

The RealFlight Control Panel is useful for many aspects of the simulation.  For 

details on the purpose and functionality of the Control Panel, See "Appendix B. 

RealFlight Control Panel" on page 42. 

Control Surface 

Generally defined as the portion of the wing that moves.  This is usually the ailerons, 

elevator, rudder, flaps or spoilers. 

Controller 

A device used to control the NexSTAR airplane in the simulation.  This is also 

referred to as the transmitter.  

Dihedral 

The V-shaped bend in the wing. Typically, more Dihedral causes more aerodynamic 

stability in an airplane, and causes the rudder to control both the roll and yaw axis. 

This is why some trainers and sailplanes require only 3 channels of radio control 

(i.e., have no ailerons).   

Direct3D Technology 

Used to render the 3D image when you have an accelerated graphics card.  It works 

best on faster computers. 

DirectX 

A technology created by Microsoft that controls graphics and sound operations. 

Dithering 

Blends the pixels together to produce a smoother image.  This can also simulate 

colors that may not be available to you. 
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Down Thrust 

This is the downward angle of the engine in relationship to the centerline of the 

airplane. Down Thrust helps overcome the normal climbing tendency of flat bottom 

wings. 

Driver 

A software program that controls a card (e.g., video or sound card) in your computer. 

The card’s manufacturer usually provides its Driver as well. Manufacturers 

frequently update their Drivers to fix bugs, or make their cards compatible with new 

software and hardware. You can often find an updated driver for your video or sound 

card by visiting the web site of the card’s manufacturer, and following links to 

“Drivers,” “Support,” “Downloads”, or “Upgrades.” 

Elevator 

Hinged control surface located at the trailing edge of the horizontal stabilizer, which 

provides control of the airplane about the pitch axis and causes the airplane to climb 

or dive. The correct direction of control is to pull the transmitter Elevator control 

stick back, toward the bottom of the transmitter, to move the Elevator upward, which 

causes the airplane to climb, and vice versa to dive. 

Flap 

For Airplanes: Hinged control surface located at the trailing edge of the wing inboard 

of the ailerons. The Flaps are lowered to produce more aerodynamic lift from the 

wing, allowing a slower takeoff and landing speed. Flaps are often found on scale 

models, but usually not on basic trainers. 

Flight Playback Gadget 

A gadget that lets you control playback of flight recordings using mouse actions. 

Frame Rate 

Frame Rate is the number of times per second that RealFlight creates a different 

picture to display on your monitor. Frame rate is determined by the speed of your 

CPU and graphics card, and how many RealFlight options you turn on. This is not 

the same as refresh rate, which is the number of times per second that your monitor 

retraces an image on its screen. 

Fuselage 

This is the main part of the airplane that holds the wings and engine.  Often thought 

of as the “body” of the airplane.  This term is also used to refer to a “body” that 

might be used on helicopters. 

Futaba 

Maker of quality R/C products. 
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Gadget 

An onscreen display that shows you continuously updated information about your 

aircraft, or lets you control RealFlight features using mouse clicks. 

Gyro 

A device, most commonly used in helicopters, that aids in controlling the yawing 

action of the helicopter by automatically adjusting the deflection of the tail rotor 

blades. 

HAL Device 

A hardware-accelerated 3D video card driver.  “HAL” is an abbreviation for the 

phrase “Hardware Abstraction Layer” that uses software drivers to communicate 

between RealFlight’s software and the hardware of the PC.  

Hot Pluggable/Hot Swappable 

A device is said to be Hot Pluggable or Hot Swappable when you can safely connect 

or disconnect it without turning off your computer or rebooting.  

PhotoField 

A technology that creates a flying field by using a panoramic photograph as a 

background for a flat terrain. RealFlight offers you a choice of two display styles for 

airports: Photofield or 3D Terrains. 3D Terrains are more realistic, but Photofield 

may render more quickly if you have an older, slower computer or graphics card. 

Pitch Axis 

The airplane axis controlled by the elevator. Pitch is illustrated by holding the 

airplane at each wingtip. Raising or lowering the nose is the pitch movement. This is 

how the climb or dive is controlled. 

Propeller 

Props are generally designated by two numbers (for instance, “10 – 6”). The first 

number is the prop's length (10" in the example). The second number is the pitch or 

angle of the blades. (In the example, “6” represents the distance the Propeller will 

move forward in one revolution, in this case 6".) 

RAM 

RAM is short for, Random Access Memory.  This is generally thought of as the 

computer’s main memory.   

RAMP 

A software-only rendering technology that is usually faster than RGB.  Please note: 

although it renders faster, it does so at the expense of quality. 
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RealPhysics 

This is RealFlight’s exclusive physics modeling technology. RealPhysics 

authentically replicates the actual physics of model aircraft by calculating hundreds 

of thousands of floating point operations each second while delivering sizzling real 

time performance.   

Refresh Rate 

The number of times per second that your monitor retraces an image on its screen. 

This is different from the Frame Rate. 

Resolution 

When used in the context of screen Resolution, this term describes the picture quality 

of the screen.  Lower Resolution produces an image that is not as sharp as higher 

Resolutions. 

Roll Axis 

The airplane axis controlled by the ailerons. Roll is illustrated by holding the 

airplane by the nose and tail. Dropping either wingtip is the roll movement. Roll is 

used to bank or turn the airplane. In most airplanes, the ailerons control roll. 

However, when the main wing has dihedral, the plane can be banked using the 

rudder only. Consequently, many planes with wing dihedral do not have ailerons, 

and the rudder controls both roll and yaw. This is one reason why most trainer 

aircraft have a large amount of dihedral—a plane with large dihedral can be 

controlled using fewer input channels. 

Rudder 

Hinged control surface located at the trailing edge of the vertical stabilizer, which 

provides control of the airplane about the Yaw axis (causes the airplane to Yaw left 

or right). Left Rudder movement causes the airplane to Yaw left, and right Rudder 

movement causes it to Yaw right.  

Servo 

The electromechanical device that moves the control surfaces or throttle of the 

airplane according to commands from the receiver. This device does the physical 

work inside the aircraft.  

Sound Card  

A card inside your computer that controls audio (what you hear over your computer 

speakers). Most sound cards plug into your computer’s motherboard. You can 

upgrade your sound card (or the software driver that controls it) without getting a 

new computer. 

Specular Highlights 

A graphics rendering technique that makes surfaces (e.g., MonoKote™) appear 

reflective, or “shiny”, in direct light (e.g., sunlight). 
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Stall 

This is what happens when an airplane’s angle of attack is too great to generate lift, 

regardless of airspeed.  During a Stall, the plane will dive and rapidly lose altitude. 

Every airfoil has an angle of attack at which it generates maximum lift.  The airfoil 

will Stall beyond this angle. 

ToolTip 

A yellow popup window that appears when you hold the mouse cursor over a 

RealFlight dialog item. The text in the ToolTip window describes the item’s 

function. 

USB 

USB, or Universal Serial Bus, is a connection protocol for computer peripheral 

devices.  This includes the RealFlight NexSTAR Edition’s USB Transmitter 

Interface Adapter.  USB technology allows you to connect multiple devices to your 

computer, and supports high data transfer rates and hot swappable. USB devices have 

a special connector that only fits into a USB port. Most modern personal computers 

have USB ports, which are clearly labeled.   

Video Card 

A card inside your computer that produces the images on your video monitor. Most 

modern 3D video cards have accelerated 3D operations—that is, they perform 

numerical calculations for rendering a 3D scene, to free up your computer’s CPU to 

perform other tasks. The video card plugs into your computer’s motherboard.  You 

can upgrade your video card (or the software driver that controls it) without 

replacing your computer. 

Virtual Flight Instructor 

This RealFlight feature lets you choose from a variety of prerecorded training 

lessons.  The maneuver is then demonstrated on screen, along with the instructor’s 

voice and control stick movements. You can speed up, slow down and even loop the 

maneuver playback for training purposes. 

VirtualRevolution  

This is the exclusive, Doppler-correct, sound technology used by RealFlight. 

Washout  

An intentional twist in the wing, causing the wing tips to have a lower angle of attack 

than the wing root. In other words, the trailing edge is higher than the leading edge at 

the wing tips. Washout helps prevent tip stalls.   

Wing Loading 

This is the amount of weight per square foot that has to be overcome to provide lift. 

It is normally expressed in ounces per square foot. This specification can be easily 

calculated as follows: If you know the square inches of the wing, simply divide by 
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144 to obtain square feet. Divide the total weight (in ounces) of the airplane by the 

wing area (in square feet). This information is valuable when deciding on which 

airplane to build next. Planes with high wing loading numbers must fly faster to stay 

in the air. These are generally "performance" airplanes. Conversely, planes with 

lower numbers do not need as much air flowing around the wing to keep it flying. 

Gliders and trainer airplanes fall into this category because slow, efficient flight is 

desirable. 

Yaw Axis 

The airplane axis controlled by the rudder. Yaw is illustrated by hanging the airplane 

level by a wire located at the center of gravity. Left or right movement of the nose is 

the Yaw movement. 
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